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Preface
The PIC18F16Q20 Curiosity Nano evaluation kit (EV73T25A) is a hardware platform to evaluate the PIC18-Q20
family microcontrollers. This board has the PIC18F16Q20 microcontroller (MCU) mounted.

The Curiosity Nano series of evaluation boards include an on-board debugger. No external tools are necessary
to program and debug the PIC18F16Q20.

• PIC18F16Q20 Curiosity Nano product page - Kit information, latest user guide, and design documentation.
• PIC18F16Q20 product page - Find documentation, data sheets, sample, and purchase microcontrollers.
• Code examples on MPLAB® Discover - Get started with code examples.
• PIC18F16Q20 Curiosity Nano on Microchip Direct - Purchase this kit on Microchip Direct.
• PIC18F16Q20 Curiosity Nano Schematics - Board schematics and history.
• PIC18F16Q20 Curiosity Nano Altium Project - Latest project revision.
• PIC18F16Q20 Curiosity Nano Design Documentation - Production files for every revision.

 PIC18F16Q20 Curiosity Nano
 PIC18F16Q20 Curiosity Nano User Guide

http://www.microchip.com/DevelopmentTools/ProductDetails.aspx?PartNO=EV73T25A
https://www.microchip.com/wwwproducts/en/PIC18F16Q20
https://mplab-discover.microchip.com/v2?dsl=q20
http://www.microchipdirect.com/ProductSearch.aspx?Keywords=EV73T25A
https://ww1.microchip.com/downloads/aemDocuments/documents/MCU08/ProductDocuments/BoardDesignFiles/PIC18F16Q20-Curiosity-Nano-Schematics.pdf
https://ww1.microchip.com/downloads/aemDocuments/documents/MCU08/ProductDocuments/BoardDesignFiles/PIC18F16Q20-Curiosity-Nano-Altium-Project.zip
https://ww1.microchip.com/downloads/aemDocuments/documents/MCU08/ProductDocuments/BoardDesignFiles/PIC18F16Q20-Curiosity-Nano-Design-Documentation.zip
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1. Features and Pinout
Features of MCU and Curiosity Nano, Board Layout Picture, Board Block Diagram, Pinout Diagram

1.1 PIC18F16Q20 Key Features
The PIC18-Q20 microcontroller family is one of the tiniest PIC18 product families available in 14/20-
pin devices for sensor-interfacing, real-time control, and communication applications.

• Multi-Voltage I/O (MVIO) interface with multiple pins powered by VDDIO2 and VDDIO3

• I3C Target module with a higher communication rate
• 10-bit 300 ksps ADC with Computation for responsive sensor designs
• 8-bit Signal Routing Port module to interconnect digital peripherals without using external pins
• Vectored interrupt controller with fixed latency for handling interrupts, system bus arbiter,
• Direct Memory Access (DMA) capabilities
• UART with support for asynchronous, DMX, DALI and LIN protocols,
• Memory Access Partition (MAP)
• Enhanced Code Protect to support users in data protection and bootloader applications
• The Device Information Area (DIA) stores factory calibration values to help improve temperature

sensor accuracy

1.2 Board Features
• PIC18F16Q20 Microcontroller
• USB Type-C® Connector
• One Yellow User LED
• One Mechanical User Switch
• One MCP1711/1.2V LDO regulator powering VDDIO3
• On-Board Debugger:

– Board identification in Microchip MPLAB® X IDE
– One green power and status LED
– Programming and debugging
– Virtual serial port (CDC)
– One debug GPIO channel (DGI GPIO)

• USB Powered
• Adjustable Target Voltage:

– MIC5353 LDO regulator controlled by the on-board debugger
– 1.8–3.6V output voltage (limited by USB input voltage)
– 500 mA maximum output current (limited by ambient temperature and output voltage)
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1.3 Board Overview
Figure 1-1. PIC18F16Q20 Curiosity Nano Board Overview
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1.4 Block Diagram
Figure 1-2. PIC18F16Q20 Curiosity Nano Board Block Diagram
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1.5 Pinout
All the PIC18F16Q20 I/O pins are accessible at the edge connectors on the board. The image below
shows the board pinout.
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Figure 1-3. PIC18F16Q20 Curiosity Nano Pinout
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Info:  Peripheral signals shown in the image above, such as UART, I2C, SPI, ADC, PWM, and
others, are shown at specific pins to comply with the Curiosity Nano Board standard. These
signals can usually be routed to alternate pins using the Peripheral Pin Select (PPS) feature
in the PIC18F16Q20.
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2. Getting Started
Getting started resources for the PIC18F16Q20 Curiosity Nano board in the MPLAB Tools Ecosystem.

2.1 Getting Started Now with PIC®/AVR®
Are you new to using PIC MCUs? Microchip MCUs are supported by our comprehensive MPLAB®

development ecosystem, which makes it easy to get your prototype up and running and includes
production-ready code generation tools. Try the interactive guide to find the necessary resources: 
Get Started Now with PIC MCUs.

1. Examples: MPLAB Discover is a tool to help you find Microchip example projects. It offers
several ways to filter projects so that you can efficiently find a Microchip-tested example, as close
as possible to your application requirements, to use as a starting point for your development.

2. Configure: MCC Melody provides Libraries, Drivers, and Peripheral Libraries (PLIB) for the
development of embedded software for a range of supported Microchip MCUs, which are
configured using MPLAB® Code Configurator (MCC).

3. Develop: MPLAB X IDE (Integrated Development Environment), which is available for Windows,
Linux and macOS, also MPLAB® XC C Compilers.

4. Debug: With the MPLAB X IDE and/or the MPLAB Data Visualizer, the PIC18F16Q20 device
on the PIC18F16Q20 Curiosity Nano board is programmed and debugged by the on-board
debugger. Therefore, no external programmer or debugger tool is required.

5. Boards: The PIC18F16Q20 Curiosity Nano board is a supported part of the Curiosity Nano
Development Platform, which includes the Curiosity Nano Base for Click Boards™.

Tip: Have a look at this free Microchip University course.

The Curiosity Nano development platform is well
suited to rapid prototyping. This course will introduce
you to the defining features of the Curiosity Nano
platform and show you how it can be leveraged using
a new microcontroller or developing a new prototype.
This course includes an in-depth look at the on-board
debugger, which is central to the platform, and how
to use its various user interfaces to help you reach
your goals quicker.

2.2 How the Curiosity Nano Fits Into the MPLAB Tools Ecosystem

2.2.1 MPLAB X IDE Support for Curiosity Nano
When the board connects to the computer for the first time, the operating system will install the
driver software. The drivers for the board are included with MPLAB® X IDE. Once this is done, when
connecting the Curiosity Nano to a host PC via USB, if MPLAB X IDE is open, a Kit Window is opened
with several key links for that Curiosity Nano.

https://www.microchip.com/en-us/products/microcontrollers-and-microprocessors/8-bit-mcus/pic-mcus/get-started-now
https://www.microchip.com/en-us/products/microcontrollers-and-microprocessors/8-bit-mcus/pic-mcus/get-started-now
https://mplab-discover.microchip.com/
https://www.microchip.com/en-us/tools-resources/configure/mplab-code-configurator/melody
https://onlinedocs.microchip.com/v2/keyword-lookup?keyword=MCC.MELODY.COMPONENT.REFERENCE&version=latest&redirect=true
https://www.microchip.com/en-us/tools-resources/configure/mplab-code-configurator
https://www.microchip.com/en-us/tools-resources/develop/mplab-x-ide
https://www.microchip.com/en-us/tools-resources/develop/mplab-xc-compilers
https://www.microchip.com/en-us/tools-resources/debug/mplab-data-visualizer
https://www.microchip.com/en-us/tools-resources/evaluation-boards/curiosity-nano
https://www.microchip.com/en-us/tools-resources/evaluation-boards/curiosity-nano
https://www.microchip.com/en-us/development-tool/AC164162
https://mu.microchip.com/rapid-prototyping-with-the-curiosity-nano-platform
https://mu.microchip.com/rapid-prototyping-with-the-curiosity-nano-platform
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When creating a new project the part number on the
Curiosity Nano will be detected, as will the debug tool.

Tip: 
• For the PIC18F16Q20 Curiosity Nano board, use MPLAB® X version 6.15, device family

pack PIC18F-Q DFP version 1.22.416, and tool pack nEDBG_TP version 1.29.32 or newer
• The latest device family packs are available through Tools > Packs in MPLAB® X IDE or

online at Microchip MPLAB® X Packs Repository. For more information on packs and
how to upgrade them, refer to the MPLAB® X IDE User’s guide - Work with Device Packs.

As shown in the image below, additional information about your Curiosity Nano can be seen in the
"Debug Tool" window once you have clicked on "Refresh Debug Tool Status"

https://packs.download.microchip.com/
https://onlinedocs.microchip.com/v2/keyword-lookup?keyword=MPLABX:PACKS&version=latest&redirect=true
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Tip: 
• If closed, reopen the Kit Window in MPLAB® X IDE through the menu bar Window > Kit

Window
• The 'How do I?' search bar often gives excellent results if you're new to MPLAB X IDE.
• 'Debug main project" will start a debug session

Tip: 
• After clicking on 'Refresh Debug Tool Status,' you can see information such as MCU

Target Voltage
• What are Program- and Data-Break Points? MPLAB X IDE Advanced Debugging -

Breakpoints Demo
• Reference for example above - MCC Melody Timer0 Driver: 100 ms Timer, API Ref Code

2.3 MPLAB Data Visualizer Support for Curiosity Nano
The Curiosity Nano, via a USB/serial bridge, facilitates a connection between a UART on the Target
MCU and your computer's COM port. For example, this can be used to connect to the MPLAB Data
Visualizer or other terminal programs.

https://youtu.be/RVPOhPopujs?list=PLtQdQmNK_0DTsTgCR47l9l6HHQIb6b3-T
https://youtu.be/RVPOhPopujs?list=PLtQdQmNK_0DTsTgCR47l9l6HHQIb6b3-T
https://youtu.be/ZmpbrB6hAuE
https://onlinedocs.microchip.com/v2/keyword-lookup?keyword=SCF-PIC8-TIMER0-V1&version=latest&redirect=true
https://onlinedocs.microchip.com/v2/keyword-lookup?keyword=MPLAB_DATA_VISUALIZER&version=latest&redirect=true
https://onlinedocs.microchip.com/v2/keyword-lookup?keyword=MPLAB_DATA_VISUALIZER&version=latest&redirect=true
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Tip: References for the example Data Visualizer Plot- and Terminal-views above:
1. Plot View - DebugIO: DebugIO Hello World (Microchip University).
2. Plot View - Serial Port: MCC Melody Use Case Data Visualizer Run Time Use Case 1.
3. Terminal - Serial Port: MCC Melody UART Driver: LED Control Commands.

2.4 Using Pin-Headers
The edge connector footprint on the PIC18F16Q20 Curiosity Nano has a staggered design where
each hole is shifted 8 mil (~0.2 mm) off-center. The hole shift allows regular 100 mil pin headers to
be used without soldering on the board. The pin-headers can be used in applications like pin sockets
and prototyping boards without issues once they are firmly in place.

https://mu.microchip.com/visual-debugging-with-mplab-data-visualizer/695707
https://www.youtube.com/watch?v=80OA-Cw0F_k
https://www.youtube.com/watch?v=yfr8Jgwljh0
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Figure 2-1. Attaching Pin-Headers to the Curiosity Nano Board

Figure 2-2. Connecting to Curiosity Nano Base for Click boards™

Tip: 
• Start at one end of the pin-header and gradually insert the header along the length of

the board. Once all the pins are in place, use a flat surface to push them in.
• For applications using the pin-headers permanently, it is still recommended to solder

them in place
• Once the pin-headers are in place, they are hard to remove by hand. Use a set of pliers

and carefully remove the pin-headers to avoid damage to the pin-headers and PCB.
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3. On-Board Debugger
Features and interfaces of the on-board debugger for programming and debugging.

3.1 On-Board Debugger Overview
PIC18F16Q20 Curiosity Nano contains an on-board debugger for programming and debugging. The
on-board debugger is a composite USB device consisting of several interfaces:
• A debugger that can program and debug the PIC18F16Q20 in MPLAB® X IDE
• A virtual serial port (CDC) that is connected to a Universal Asynchronous Receiver/Transmitter

(UART) on the PIC18F16Q20 and provides an easy way to communicate with the target
application through terminal software

• A mass storage device that allows drag-and-drop programming of the PIC18F16Q20
• A Data Gateway Interface (DGI) for code instrumentation with logic analyzer channels (debug

GPIO) to visualize program flow

The on-board debugger controls a Power and Status LED (marked PS) on the PIC18F16Q20 Curiosity
Nano board. The table below shows how the different operation modes control the LED.

Table 3-1. On-Board Debugger LED Control
Operation Mode Power and Status LED

Boot Loader mode The LED blinks slowly during power-up

Power-up The LED is ON

Normal operation The LED is ON

Programming Activity indicator: The LED blinks slowly during programming/debugging

Drag-and-drop programming
Success: The LED blinks slowly for 2 sec.
Failure: The LED blinks rapidly for 2 sec.

Fault The LED blinks rapidly if a power fault is detected

Off The on-board debugger is powered down, the LED is OFF

Info: Slow blinking is approximately 1 Hz, and rapid blinking is about 5 Hz.

3.2 On-Board Debugger Connections
The table below shows the connections between the target and the debugger section. All the
connections between the target and the debugger are tri-stated when the debugger is not using
the interface. Hence, there are few contaminations of the signals, e.g., the pins can be configured to
anything the user wants.

Info: The 12-edge connections closest to the USB connector on Curiosity Nano boards
have a standardized pinout. The program/debug pins have different functions depending
on the target programming interface.

Table 3-2. On-Board Debugger Connections
Debugger Pin PIC18F16Q20 Pin Description

CDC TX RC5 UART RX USB CDC TX line

CDC RX RC4 UART TX USB CDC RX line
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...........continued
Debugger Pin PIC18F16Q20 Pin Description

DBG0 RA0 ICSPDAT Debug data line

DBG1 RA1 ICSPCLK Debug clock line

DBG2 RA2 SW0/GPIO0 Debug GPIO0/SW0

DBG3 RA3 MCLR Reset line

ID — — ID line for extensions

NC — — No connect

VBUS — — VBUS voltage for external use

VOFF — — Voltage Off input. Disables the target regulator
and target voltage when pulled low.

VTG — — Target voltage

GND — — Common ground

Figure 3-1. Curiosity Nano Debugger Pinout
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Tip: For the complete PIC18F16Q20 Curiosity Nano pinout, see the PIC18F16Q20 Curiosity
Nano Pinout.

3.3 Debugger USB Enumeration
The on-board debugger on the PIC18F16Q20 Curiosity Nano board appears as a Human Interface
Device (HID) on the host computer’s USB subsystem. The debugger supports full-featured
programming and debugging of the PIC18F16Q20 by using MPLAB X IDE.

Remember: Keep the debugger’s firmware up-to-date. Firmware upgrades automatically
when using MPLAB X IDE.

3.4 Virtual Serial Port (CDC)
The virtual serial port (CDC) is a general purpose serial bridge between a host PC and a target
device.

3.4.1 Overview
The on-board debugger implements a composite USB device with a standard Communications
Device Class (CDC) interface, which appears on the host as a virtual serial port. Use the CDC to
stream arbitrary data between the host computer and the target in both directions: All characters
sent through the virtual serial port on the host computer will be transmitted as UART on the
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debugger’s CDC TX pin. The UART characters captured on the debugger’s CDC RX pin will be
returned to the host computer through the virtual serial port.

Figure 3-2. CDC Connection

Debugger

CDC TX

CDC RX

Target MCU

USB
PC

Terminal
Software

Terminal
Send

Terminal
Receive

Target
Receive

Target
Send

UART RX

UART TX
USB

Info: The debugger’s CDC TX pin is connected to a UART RX pin on the target for receiving
characters from the host computer, as shown in the figure above. Similarly, the debugger’s
CDC RX pin is connected to a UART TX pin on the target for transmitting characters to the
host computer.

3.4.2 Operating System Support
On Windows® machines, the CDC will enumerate as Curiosity Virtual COM Port and appear in the
Ports section of the Windows Device Manager. The COM port number can also be found there.

Info: On older Windows systems, the CDC requires a USB driver. The MPLAB X IDE
installation include this driver.

On Linux® machines, the CDC will enumerate and appear as /dev/ttyACM#.

Info: tty* devices belong to the “dialout” group in Linux, so it may be necessary to become
a member of that group to have permission to access the CDC.

On Mac® machines, the CDC will enumerate and appear as /dev/tty.usbmodem#. Depending on
the terminal program used, it will appear in the available list of modems as usbmodem#.

Info: For all operating systems, use a terminal emulator that supports DTR signaling. See
3.4.4.  Signaling.

3.4.3 Limitations
Not all UART features are implemented in the on-board debugger CDC. The constraints are outlined
here:

• Baud rate: Must be in the range of 1200 bps to 500 kbps. Any baud rate outside this range will be
set to the closest limit without warning. Baud rate can be changed on-the-fly.
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• Character format: Only 8-bit characters are supported.
• Parity: Can be odd, even, or none.
• Hardware flow control: Not supported.
• Stop bits: One or two bits are supported.

3.4.4 Signaling
During USB enumeration, the host OS will start both the communication and data pipes of the CDC
interface. At this point, it is possible to set and read back the baud rate and other UART parameters
of the CDC, but data sending and receiving will not be enabled.

The terminal must assert the DTR signal when it connects to the host. As this is a virtual control
signal implemented on the USB interface, it is not physically present on the board. Asserting the
DTR signal from the host will indicate to the on-board debugger that a CDC session is active.
The debugger will enable its level shifters (if available) and start the CDC data send and receive
mechanisms.

Deasserting DTR in debugger firmware version 1.20 or earlier has the following behavior:
• Debugger UART receiver is disabled, and no further data will be transferred to the host computer
• Debugger UART transmitter will continue to send queued data ready for transfer, but no new

data is accepted from the host computer
• Level shifters (if available) are not disabled, and the debugger CDC TX line remains driven

Deasserting DTR in debugger firmware version 1.21 or later has the following behavior:
• Debugger UART receiver is disabled, and no further data will be transferred to the host computer
• Debugger UART transmitter will continue to send queued data ready for transfer, but no new

data is accepted from the host computer
• Once the ongoing transmission is complete, level shifters (if available) are disabled, and the

debugger CDC TX line will become high-impedance

Remember: Set up the terminal emulator to assert the DTR signal. Without the signal, the
on-board debugger will not send or receive data through its UART.

Tip: The on-board debugger’s CDC TX pin will not be driven until the CDC interface is
enabled by the host computer. Also, there are no external pull-up resistors on the CDC
lines connecting the debugger and the target, meaning the lines are floating during power-
up. The target device may enable the internal pull-up resistor on the pin connected to the
debugger’s CDC TX pin to avoid glitches resulting in unpredictable behavior like framing
errors.

3.4.5 Advanced Use
CDC Override Mode
In ordinary operation, the on-board debugger is a true UART bridge between the host and the
device. However, in certain use cases, the on-board debugger can override the basic Operating
mode and use the CDC TX and RX pins for other purposes.

Dropping a text file into the on-board debugger’s mass storage drive can be used to send characters
out of the debugger’s CDC TX pin. The filename and extension are trivial, but the text file will start
with the characters:
CMD:SEND_UART=
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Debugger firmware version 1.20 or earlier has the following limitations:
• The maximum message length is 50 characters – all remaining data in the frame are ignored
• The default baud rate used in this mode is 9600 bps, but if the CDC is already active or

configured, the previously used baud rate still applies

Debugger firmware version 1.21 and later has the following limitations/features:
• The maximum message length will vary depending on the MSC/SCSI layer timeouts on the host

computer and/or operating system. A single SCSI frame of 512 bytes (498 characters of payload)
is ensured, and files up to 4 KB will work on most systems. The transfer will complete on the first
NULL character encountered in the file.

• The baud rate used is always 9600 bps for the default command:
CMD:SEND_UART=

• Do not use the CDC Override mode simultaneously with data transfer over the CDC/terminal.
If a CDC terminal session is active when receiving a file via the CDC Override mode, it will be
suspended for the duration of the operation and resumed once complete.

• Additional commands are supported with explicit baud rates:
CMD:SEND_9600=

CMD:SEND_115200=

CMD:SEND_460800=

USB-Level Framing Considerations
Sending data from the host to the CDC can be done byte-wise or in blocks, chunked into 64-byte
USB frames. Each frame will be queued for transfer to the debugger’s CDC TX pin. Sending a
small amount of data per frame can be inefficient, particularly at low baud rates, as the on-board
debugger buffers frames but not bytes. A maximum of four 64-byte frames can be active at any
time. The on-board debugger will throttle the incoming frames accordingly. Sending full 64-byte
frames containing data is the most efficient method.

When receiving data on the debugger’s CDC RX pin, the on-board debugger will queue up the
incoming bytes into 64-byte frames, which are sent to the USB queue for transmission to the host
when they are full. Incomplete frames are also pushed to the USB queue at approximately 100 ms
intervals, triggered by USB start-of-frame tokens. Up to eight 64-byte frames can be active at any
time.

An overrun will occur if the host (or the software running on it) fails to receive data fast enough.
When this happens, the last-filled buffer frame recycles instead of being sent to the USB queue, and
a complete data frame will be lost. To prevent this occurrence, the user will ensure that the CDC data
pipe is continuously read, or the incoming data rate will be reduced.

Sending Break Characters
The host can send a UART break character to the device using the CDC, which can be useable
for resetting a receiver state-machine or signaling an exception condition from the host to the
application running on the device.

A break character is defined as a sequence of at least 11 zero bits transmitted from the host to the
device.

Not all UART receivers have support for detecting a break, but a correctly-formed break character
usually triggers a framing error on the receiver.

Sending a break character using the debugger's CDC has the following limitations:
• Sending a break must NOT be done simultaneously, as using the CDC Override mode (drag-and-

drop). Both these functions are temporary states and must be used independently.
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• Sending a break will cause the data currently being sent to be lost. Be sure to wait a sufficient
amount of time to allow all characters in the transmission buffer to be sent (see above section)
before sending the break, which is also in line with expected break character usage: For example,
reset a receiver state-machine after a timeout occurs waiting for returning data to the host.

• The CDC specification allows for debugger-timed breaks of up to 65534 ms in duration to be
requested. For simplicity, the debugger will limit the break duration to a maximum of 11 bit-
durations at its minimum supported baud rate.

• The CDC specification allows for indefinite host-timed breaks. It is the responsibility of the
terminal application/user to release the break state in this case.

Note:  Sending break characters is available in debugger firmware version 1.24 and later.

3.5 Mass Storage Device
The on-board debugger includes a simple Mass Storage Device implementation, which is accessible
for read/write operations via the host operating system to which it is connected.

It provides:
• Read access to basic text and HTML files for detailed kit information and support
• Write access for programming Intel® HEX formatted files into the target device’s memory
• Write access for simple text files for utility purposes

3.5.1 Mass Storage Device Implementation
The on-board debugger implements a highly optimized variant of the FAT12 file system with several
limitations, partly due to the nature of FAT12 itself and optimizations made to fulfill its purpose for
its embedded application.

The Curiosity Nano USB device is USB Chapter 9-compliant as a mass storage device but does
not, in any way, fulfill the expectations of a general purpose mass storage device. This behavior is
intentional.

When using the Windows operating system, the on-board debugger enumerates as a Curiosity Nano
USB Device found in the disk drives section of the device manager. The CURIOSITY drive appears in
the file manager and claims the following available drive letter in the system.

The CURIOSITY drive contains approximately one MB of free space and does not reflect the target
device’s Flash size. When programming an Intel HEX file, the binary data are encoded in ASCII with
metadata providing a vast overhead, so 1 MB is a trivially chosen value for disk size.

It is not possible to format the CURIOSITY drive. The filename may appear in the disk directory listing
when programming a file to the target, which is merely the operating system’s view of the directory
that, in reality, has not been updated. It is not possible to read out the file contents. Removing and
replugging the board will return the file system to its original state, but the target will still contain the
previously programmed application.

Copy a text file starting with “CMD:ERASE” onto the disk to erase the target device.

By default, the CURIOSITY drive contains several read-only files for generating icons as well as
reporting status and linking to further information:

• AUTORUN.ICO – icon file for the Microchip logo

• AUTORUN.INF – system file required for Windows Explorer to show the icon file

• KIT-INFO.HTM – redirect to the development board website

• KIT-INFO.TXT – a text file containing details about the board’s debugger firmware version,
board name, USB serial number, device, and drag-and-drop support

• STATUS.TXT – a text file containing the programming status of the board
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Info: The on-board debugger dynamically updates STATUS.TXT. The contents may not
reflect the correct status as the OS may cache it.

3.5.2 Special Commands
Several utility commands are supported by copying text files to the mass storage disk. The filename
or extension is irrelevant – the command handler reacts to content only.

Table 3-3. Special File Commands
Command Content Description

CMD:ERASE Executes a chip erase of the target

CMD:SEND_UART= Sends a string of characters to the CDC UART. See “CDC Override
Mode.”

CMD:SEND_9600=
CMD:SEND_115200=
CMD:SEND_460800=

Sends a string of characters to the CDC UART at the specified baud
rate. Note that only the baud rates explicitly specified here are
supported. See “CDC Override Mode.” (Debugger firmware v1.25.6
or newer.)

CMD:RESET Resets the target device by entering Programming mode and exiting
Programming mode immediately afterward. The exact timing can
vary according to the programming interface of the target device.
(Debugger firmware v1.25.6 or newer.)

CMD:POWERTOGGLE Powers down the target and restores it after a 100 ms delay. If
external power is provided, this has no effect. (Debugger firmware
v1.25.6 or newer.)

CMD:0V Powers down the target device by disabling the target supply
regulator. If external power is provided, this has no effect. (Debugger
firmware v1.25.6 or newer.)

CMD:1V8 Sets the target voltage to 1.8V. If external power is provided, this has
no effect. (Debugger firmware v1.25.6 or newer.)

CMD:3V3 Sets the target voltage to 3.3V. If providing external power, this has
no effect. (Debugger firmware v1.25.6 or newer.)

Info: The content sent to the mass storage emulated disk triggers the commands listed
here and provides no feedback in the case of either success or failure.

3.6 Data Gateway Interface (DGI)
Data Gateway Interface (DGI) is a USB interface transporting raw and timestamped data between
on-board debuggers and host computer-based visualization tools. MPLAB Data Visualizer is used on
the host computer to display any debug GPIO data. It is available as a plug-in for MPLAB X IDE or a
stand-alone application that can be used in parallel with MPLAB® X IDE.

Although DGI encompasses several physical data interfaces, the PIC18F16Q20 Curiosity Nano
implementation includes logic analyzer channels:
• One debug GPIO channel (also known as DGI GPIO)

3.6.1 Debug GPIO
Debug GPIO channels are timestamped digital signal lines connecting the target application to a
host computer visualization application. They are typically used to plot low-frequency events on a
time axis, such as when given Application state transitions occur.

https://www.microchip.com/en-us/development-tools-tools-and-software/embedded-software-center/mplab-data-visualizer
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The figure below shows the monitoring of the Digital state of a mechanical switch connected to a
debug GPIO in MPLAB Data Visualizer.

Figure 3-3. Monitoring Debug GPIO with MPLAB Data Visualizer

Debug GPIO channels are timestamped, so the resolution of DGI GPIO events is determined by the
resolution of the DGI Timestamp module.

Important: Although signal bursts of higher frequency can be captured, the frequency
range of signals for which debug GPIO can be used is up to about 2 kHz. Attempting to
capture signals above this frequency will result in data saturation and overflow, which may
cause the DGI session to be aborted.

3.6.2 Timestamping
When captured by the debugger, DGI sources are timestamped. The timestamp counter
implemented in the Curiosity Nano debugger increments at a 2 MHz frequency, providing a
timestamp resolution of a half microsecond.
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4. Hardware Implementation
LED, Mechanical Switch, Power Supply

4.1 Multi-Voltage I/O
The PIC18F16Q20 Curiosity Nano MCU supports Multi-Voltage I/O (MVIO), and the PIC18F16Q20
features two MVIO domains powered by VDDIO2 and VDDIO3. The pins RC0 and RC1 are powered
through VDDIO2, and the pins RB5 and RB6 are powered through VDDIO3. The I/O pins connected to
the MVIO feature are powered only by the additional VDDIOx pins. If no power is supplied to these
power pins, the associated I/O pins will not function.

By default VDDIO2, is supplied by VCC_TARGET, and VDDIO3 is supplied by its own 1.2V regulator,
MCP1711 (U101). VDDIO2 and VDDIO3 can be disconnected from their default power connections by
removing the 0Ω resistors R105 and/or R106. After the removal, an external power supply can
power the MVIO pins through the associated 1x2-100mil footprints. The block diagram below details
connections to the different power domains.

Important: When the I3C module is enabled, the MVIO supply voltage on the
corresponding VDDIOx power pin must not exceed 3.63V. To avoid accidentally damaging
the PIC18F16Q20, the target regulator is limited to 1.8–3.6V.

Figure 4-1. MVIO Block Diagram

PIC18F16Q20
MCU

1x2 100mil
Footprint

1x2 100mil
Footprint

VDDIO2

RC0

RC1

J107J108

Adjustable Target Regulator
(1.8-3.6V)

0-Ohm
Resistor

0-Ohm
Resistor

VDD

R106 R105

VDDIO3

RB6

RB5

VDDIO3 Regulator
(1.2V)

U101U200

U100

I3C2 SCL

I3C2 SDAI3C1 SDA

I3C1 SCL

VCC_TARGET VCC_VDDIO3_P1V2

WARNING Supplying a voltage greater than 3.6V to any VDDIOx power pin while I3C is enabled may
damage the PIC18F16Q20.

https://www.microchip.com/en-us/product/MCP1711


 PIC18F16Q20 Curiosity Nano User Guide
Hardware Implementation

 User Guide
© 2023 Microchip Technology Inc. and its subsidiaries

DS50003588A - 21

Figure 4-2. VDDIO2 and VDDIO3 Connections

R105

J107

J108

R106

U101

WARNING Before any hardware modifications, make sure the board is disconnected from the USB or
external power.

Disconnecting VDDIO2:
• Disconnect VDDIO2 from VCC_TARGET by removing resistor R106
• Connect a new power supply to VDDIO2 and ground at J108
• J108 does not have reverse polarity protection. Make sure to match the polarity between the

power supply and J108. Positive-polarity to J108-pin 1 and negative-polarity to J108-pin 2

Figure 4-2 shows the resistor R106, VDDIO2 and J108.

Disconnecting VDDIO3:
• Disconnect VDDIO3 from VCC_VDDIO3_P1V2 by removing resistor R105
• Connect a new power supply to VDDIO3 and ground at J107
• J107 does not have reverse polarity protection. Make sure to match the polarity between the

power supply and J107. Positive-polarity to J107-pin 1 and negative-polarity to J107-pin 2

Figure 4-2 shows the resistor R105, VDDIO3 and J107.

WARNING Applying an external voltage to VDDIO2 or VDDIO3 without removing the resistor(s) may cause
permanent damage to the board!

WARNING J107 and J108 do not have reverse polarity protection. Applying voltage to the wrong pin
may cause permanent damage to the board.
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4.1.1 I3C Considerations
While the PIC18F16Q20 supports operating voltages from 1.8-5.5V the PIC18F16Q20 Curiosity Nano
is limited in its target voltage to 1.8–3.6V. The PIC18F16Q20 Curiosity Nano target voltage limit is set
to accommodate the low voltage I3C capabilities of the PIC18F16Q20.

As the maximum voltage for the VDDIOx power domains while I3C is enabled is 3.63V, and VDDIO2 is by
default connected to VCC_TARGET, the PIC18F16Q20 Curiosity Nano is limited to a maximum target
voltage of 3.6V.

The PIC18F16Q20 supports limited operation in the 0.95-1.62V range for low voltage I3C and I2C.
Any other pin functionality is unusable while in this low voltage range. VDDIO3 is supplied with a
fixed 1.2V, which means that the pins RB5 and RB6 are limited to I3C or I2C functionality. Hardware
modification is required to use these pins for any other purpose.

Tip: For more information on low voltage and the MVIO feature see the PIC18F16Q20 Data
Sheet.

4.2 LED
One yellow user LED is available on the PIC18F16Q20 Curiosity Nano board. Either GPIO or PWM can
control it. Driving the connected I/O line to GND can also activate the LED.

Figure 4-3. PIC18F16Q20 Curiosity Nano LED0 Block Diagram

PIC18F16Q20 MCU

R104

RC7

Edge Connector

"RC7"

VCC

LED0

Table 4-1. LED Connection
PIC18F16Q20 Pin Function Shared Functionality

RC7 Yellow LED0 Edge connector

4.3 Mechanical Switch
The PIC18F16Q20 Curiosity Nano board has one mechanical switch - a generic user-configurable
switch. Pressing it will connect the I/O pin to ground (GND).

https://www.microchip.com/en-us/product/PIC18F16Q20#document-table
https://www.microchip.com/en-us/product/PIC18F16Q20#document-table
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Figure 4-4. PIC18F16Q20 Curiosity Nano SW0 Block Diagram

PIC18F16Q20 MCU

Level Shifter

"RC7"

J106 SW0R103

RA2

Debugger

DBG2

Edge Connector

"DBG2" "RA2"

U204

Tip: There is no externally connected pull-up resistor on the switch. Enable the internal
pull-up resistor on Pin RA2 to use it.

Table 4-2. Mechanical Switch Connection
PIC18F16Q20 Pin Description Shared Functionality

RA2 User switch (SW0) Edge connector

4.4 Power Supply
The USB port powers the board. The input power is delayed to allow USB cable oscillations to die
out. The delay is about 1 ms. VBUS is further limited to a 2 V/ms slew rate and is current limited to
500 mA by U202 (MIC2008).

Tip: Changing the values for C206 and R211 can alter the slew rate and current limit set by
U202.

The power supply consists of two LDO regulators, one to generate 3.3V for the on-board debugger
and an adjustable LDO regulator for the target PIC18F16Q20 microcontroller and its peripherals. The
voltage from a USB connector can vary between 4.4V and 5.25V (according to the USB specification)
and will limit the maximum voltage supplied to the target. The figure below shows the entire power
supply system on the PIC18F16Q20 Curiosity Nano.

Figure 4-5. Power Supply Block Diagram
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https://www.microchip.com/en-us/product/MIC2008
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4.4.1 Cut Straps
All power and debugging signals are connected to the target by default. The following cut straps are
available to take measurements or separate the debugger from the target:
• Target Power Strap (J201)
• Power Supply Strap (J200)
• Debugger Pins (J101, J102, J104, J105, J106)

Figure 4-6. Common Curiosity Nano Cut Straps

Target Power
Strap

Power Supply
Strap

GPIO
Straps

4.4.2 Target Regulator
The target voltage regulator is a MIC5353 variable output LDO. The on-board debugger can adjust
the voltage output supplied to the board target section by manipulating the MIC5353’s feedback
voltage. The hardware implementation is limited to an approximate voltage range from 1.7V to 5.1V.
Additional output voltage limits are configured in the debugger firmware to ensure that the output
voltage never exceeds the hardware limits of the PIC18F16Q20 microcontroller. The voltage limits
configured in the on-board debugger on PIC18F16Q20 Curiosity Nano are 1.8–3.6V.

Info: The factory default target voltage is 3.3V. It can be changed through the MPLAB® X
IDE project properties. Any change to the target voltage is persistent, even after a power
toggle. The resolution is less than 5 mV but may be limited to 10 mV by the adjustment
program.

Info: The voltage settings setup in MPLAB® X IDE is not applied immediately to the board.
The new voltage setting is applied to the board when accessing the debugger, like pushing
the Refresh Debug Tool Status button in the project dashboard tab or programming/
reading program memory.

Info: There is an easy option to adjust the target voltage with a drag-and-drop command
text file to the board, which supports a set of commonly used target voltages. See section
3.5.2.  Special Commands for further details.

MIC5353 supports a maximum current load of 500 mA. It is an LDO regulator in a small package
placed on a small printed circuit board (PCB) and can reach the thermal shutdown condition at
lower loads than 500 mA. The maximum current load depends on the input voltage, the selected
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output voltage, and the ambient temperature. The figure below shows the safe operating area for
the regulator, with an input voltage of 5.1V and an ambient temperature of 23°C.

Figure 4-7. Target Regulator Safe Operation Area

The voltage output of the target regulator is continuously monitored (measured) by the on-board
debugger. An error condition will be flagged - and the target voltage regulator will be switched off,
detecting and handling any short-circuit conditions if it is more than 100 mV over/under the set
device voltage. It will also detect and handle if an external voltage, which causes VCC_TARGET to
move outside the voltage setting monitoring window of ±100 mV, is suddenly applied to the VTG pin
without setting the VOFF pin low.

Info: The on-board debugger has a monitoring window of VCC_TARGET±100 mV, and the
status LED will blink rapidly if the external voltage is under this limit. The on-board
debugger status LED will continue to shine if the external voltage surpasses this limit.
When removing the external voltage, the status LED will start blinking rapidly until the
on-board debugger detects the new situation and turns the target voltage regulator back
on.

4.4.3 External Supply
Instead of the on-board target regulator, an external voltage can power the PIC18F16Q20 Curiosity
Nano. When shorting the Voltage Off (VOFF) pin to the ground (GND) pin, the on-board debugger
firmware disables the target regulator, and it is safe to apply an external voltage to the VTG pin.

It is also safe to apply an external voltage to the VTG pin when no USB cable is plugged into the
DEBUG connector on the board.

The VOFF pin can be tied low/let go at any time, which will be detected by a pin-change interrupt to
the on-board debugger, which controls the target voltage regulator accordingly.

WARNING Applying an external voltage to the VTG pin without shorting VOFF to GND may cause
permanent damage to the board.
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WARNING Do not apply any voltage to the VOFF pin. Let the pin float to enable the power supply.

WARNING The absolute maximum external voltage is 5.5V for the on-board level shifters, and the
standard operating condition of the PIC18F16Q20 is 1.8–3.6V. Applying a higher voltage
may cause permanent damage to the board.

Info: The on-board debugger monitors the voltage supplied to the board. If VOFF is not
pulled low and external power is supplied that differs by more than ±100 mV from the
target regulator setting, the on-board debugger will shut off the target regulator and
begin blinking the status LED rapidly, indicating an error condition. Once the input voltage
returns to within ±100 mV of the target regulator setting, the on-board debugger will switch
on the target regulator and stop blinking the status LED.

Programming, debugging, and data streaming are still possible with an external power supply. The
USB cable will power the debugger and signal level shifters. Both regulators, the debugger, and the
level shifters are powered down when the USB cable is removed.

Info: In addition to the power consumed by the PIC18F16Q20 and its peripherals,
approximately 100 µA will be drawn from any external power source to power the on-
board level shifters and voltage monitor circuitry when plugging a USB cable into the
DEBUG connector on the board. When a USB cable is unplugged, some current is used
to supply the level shifter’s voltage pins, having a worst-case current consumption of
approximately 5 µA. Typical values may be as low as 100 nA.

4.4.4 Power Supply Exceptions
This section sums up most exceptions that can occur with the power supply.

Target Voltage Shuts Down
Not reaching the target voltage setting can happen if the target section draws too much current at
a given voltage and causes the thermal shutdown safety feature of the MIC5353 regulator to kick in.
To avoid this, reduce the current load of the target section.

Target Voltage Setting is Not Reached
The USB input voltage (specified to be 4.4-5.25V) limits the maximum output voltage of the MIC5353
regulator at a given voltage setting and current consumption. If a higher output voltage is needed,
use a USB power source with a higher input voltage or use an external voltage supply on the VTG
pin.

Target Voltage is Different From Setting
An externally applied voltage to the VTG pin without setting the VOFF pin low can cause this. If the
target voltage varies more than 100 mV over/under the voltage setting, the on-board debugger will
detect it, and the internal voltage regulator will shut down. To fix this issue, remove the applied
voltage from the VTG pin, and the on-board debugger will enable the on-board voltage regulator
when the new condition is detected. Note that the PS LED will blink rapidly if the target voltage is
below 100 mV of the setting but will ordinarily turn on when higher than 100 mV above it.

No, or Very Low Target Voltage and PS LED is Blinking Rapidly
A full or partial short circuit can cause this and is a particular case of the issue above. Remove it, and
the on-board debugger will re-enable the on-board target voltage regulator.
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No Target Voltage and PS LED is Lit 1
This situation occurs if the target voltage is set to 0.0V. Set the target voltage to a value within the
specified voltage range for the target device to fix this.

No Target Voltage and PS LED is Lit 2
This situation can be the issue when cutting power jumper J200 and/or J201 and setting the target
voltage regulator to a value within the specified voltage range for the target device. To fix this, solder
a wire/bridge between the pads for J200/J201 or add a jumper on J201 if a pin-header is mounted.

VBUS Output Voltage is Low or Not Present
If the VBUS output voltage is low or missing, the reason is probably a high-current drain on VBUS,
and the current limit set by U202 (MIC2008) is tripped and has cut off VBUS completely. Reduce the
current consumption on the VBUS pin to fix this issue.

4.4.5 Low-Power Measurement
Power to the PIC18F16Q20 comes from the on-board power supply and VTG pin through a 100 mil
pin-header marked with “POWER” in silkscreen (J201). To measure the power consumption of the
PIC18F16Q20 and other peripherals connected to the board, cut the Target Power strap (J201) on the
bottom side and connect an ammeter across it.

Tip: A 100-mil pin-header can be soldered into the Target Power strap (J201) footprint for
a simple connection of an ammeter. Place a jumper cap on the pin-header once the
ammeter is no longer needed.

To measure the lowest possible power consumption, follow these steps:
1. Cut the POWER strap with a sharp tool.
2. Solder a 1x2 100 mil pin-header in the footprint.
3. Connect an ammeter to the pin header.
4. Write firmware that:

a. Tri-states any I/O connected to the on-board debugger.
b. Sets the microcontroller in its lowest Power sleep mode.

5. Program the firmware into the PIC18F16Q20.

Info: The on-board level shifters will draw a small amount of current even when unused.
Each level shifter has a maximum of 2 μA leakage current. Therefore, the worst-case
maximum current draw for the five on-board level shifters is 10 μA. Prevent leakage
current through an I/O pin connected to a level shifter by keeping the I/O pin tri-stated.
All I/Os connected to the on-board debugger are listed in 3.2.  On-Board Debugger
Connections. The on-board level shifters can be completely disconnected, preventing
leakage, as described in 6.6.  Disconnecting the On-Board Debugger.

4.4.6 VBUS Output Pin
PIC18F16Q20 Curiosity Nano has a VBUS output pin that can be used to power external components
that need a 5V supply. The VBUS output pin is protected by the same start-up delay with a slew
rate and current limiter as the rest of the power supply. A side effect is a voltage drop on the VBUS
output with higher current loads. The chart below shows the VBUS output voltage versus the current
load of the VBUS output.

https://www.microchip.com/en-us/product/MIC2008
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Figure 4-8. VBUS Output Voltage vs. Current
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5. Revision History
Hardware and Document Revision History

5.1 Hardware Revision History and Known Issues
This user guide provides information about the latest available revision of the board. The following
sections contain information about known issues, a revision history of older revisions, and how older
revisions differ from the latest revision.

5.1.1 Identifying Product ID and Revision
There are two ways to find the revision and product identifier of the PIC18F16Q20 Curiosity Nano:
Either by utilizing the MPLAB X IDE Kit Window or by looking at the sticker on the bottom of the PCB.

The Kit Window will pop up when connecting PIC18F16Q20 Curiosity Nano to a computer with
MPLAB X IDE running. The first six digits of the serial number, listed under kit information, contain
the product identifier and revision.

Tip:  If closed, the Kit Window can be opened in MPLAB X IDE through the menu bar
Window > Kit Window.

The same information is found on the sticker on the bottom side of the PCB. Most boards will have
the identifier, revision, serial number, and manufacturing date printed in plain text as 02-nnnn\rr
SN: mmmssssss [Manufacturing date], where “nnnn” is the identifier, “rr” is the revision, "mmm" is
the manufacturer, and "ssssss" is the serial number.

The serial number string has the following format:

"nnnnnnrrmmmssssss"

n = product identifier

r = revision

m = manufacturer

s = serial number

The product identifier for PIC18F16Q20 Curiosity Nano is 02-00457.

5.1.2 Revision 3
Revision 3 is the initially released board revision. It has PIC18F16Q20 rev. B2 mounted.

5.2 Document Revision History
Doc. Rev. Date Comments

A 10/2023 Initial document release
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6. Appendix
Schematic, Assembly Drawing, Adapter Pinout, Programming External MCUs, External Debuggers
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6.1 Schematic
rotatethispage90

Figure 6-1. PIC18F16Q20 Curiosity Nano MCU Schematic rotatethispage90
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Figure 6-2. PIC18F16Q20 Curiosity Nano Debugger Schematic rotatethispage90
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- The level shifters have a minimal voltage level of 1.65V and will limit the minimum operating 
voltage allowed for the target to still allow communication. 
- The MIC94163 has a minimal volatege level of 1.70V and will limit the minimum voltage 
delivered to the target. 
- Firmware configuration will limit the voltage range to be within the the target specification. 

Programming 
connector for factory 
programming of 
Debugger.

SLEW RATE LIMIT: 
- With C206 set to 2200pF, the slew rate of VCC_VBUS is limited to 2 V/ms 
by the power switch MIC2008. 

CURRENT LIMIT: 
- With R211 set to 470ohm, the current through the power switch MIC2008 is 
limited to 500mA. 
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- For current measurements using the on-board power supply, this strap must be cut and an 
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Maximum output voltage is limited by the input voltage and the dropout voltage in 
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(Vmax = Vin - dropout)
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6.2 Assembly Drawing
Figure 6-3. PIC18F16Q20 Curiosity Nano Assembly Drawing Top
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6.3 Curiosity Nano Base for Click boards™

Figure 6-5. PIC18F16Q20 Curiosity Nano Pinout Mapping
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6.4 Programming External Microcontrollers
Use the on-board debugger on PIC18F16Q20 Curiosity Nano to program and debug microcontrollers
on external hardware.

6.4.1 Supported Devices
All external AVR microcontrollers with the UPDI interface can be programmed and debugged with
the on-board debugger with Microchip Studio.

External SAM microcontrollers having a Curiosity Nano Board can be programmed and debugged
with the on-board debugger with Microchip Studio.

PIC18F16Q20 Curiosity Nano can program and debug external PIC18F16Q20 microcontrollers with
MPLAB X IDE.

6.4.2 Software Configuration
No software configuration is required to program and debug the same device mounted on the
board.

To program and debug a different microcontroller than the one mounted on the board, configure
Microchip Studio to allow an independent selection of devices and programming interfaces.

1. Navigate to Tools > Options through the menu system at the application top.
2. Select the Tools > Tool settings category in the options window.
3. Set the Hide unsupported devices option to False.

Figure 6-6. Hide Unsupported Devices

Info:  Microchip Studio allows any microcontroller and interface to be selected when the
Hide unsupported devices setting is set to False - also microcontrollers and interfaces not
supported by the on-board debugger.
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6.4.3 Connecting to External Microcontrollers
The figure and table below show where to connect the programming and debugging signals to
program and debug external microcontrollers. The on-board debugger can supply power to the
external hardware or use an external voltage reference for its level shifters. Read more about the
power supply in 4.4.  Power Supply.

The on-board debugger and level shifters actively drive data and clock signals used for programming
and debugging (DBG0, DBG1, and DBG2). Pull-down resistors are required on the ICSP™ data and
clock signals to debug PIC® microcontrollers. All other interfaces are functional with or without
pull-up or pull-down resistors.

DBG3 is an open-drain connection and requires a pull-up resistor to function.

PIC18F16Q20 Curiosity Nano has pull-down resistors R100 and R101 connected to the ICSP data
and clock signal (DBG0 and DBG1). A pull-up resistor R102 is connected to the MCLR signal (DBG3).
6.2.  Assembly Drawing in the appendix shows the location of pull resistors.

Remember: 
• Connect GND and VTG to the external microcontroller
• Tie the VOFF pin to GND if the external hardware has a power supply
• Make sure there are pull-down resistors on the ICSP data and clock signals (DBG0 and

DBG1) to support the debugging of PIC microcontrollers

Figure 6-7. Curiosity Nano Standard Pinout
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Table 6-1. Programming and Debugging Interfaces
Curiosity Nano Pin UPDI ICSP™ SWD

DBG0 UPDI DATA SWDIO

DBG1 — CLK SWCLK

DBG2 — — —

DBG3 — MCLR RESET

6.5 Connecting External Debuggers
Even though there is an on-board debugger, external debuggers can be connected directly to the
PIC18F16Q20 Curiosity Nano to program/debug the PIC18F16Q20. When not actively used, the
on-board debugger keeps all the pins connected to the PIC18F16Q20 and board edge in tri-state.
Therefore, the on-board debugger will not interfere with any external debug tools.
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Figure 6-8. Connecting the MPLAB® PICkit™ 5 In-Circuit Debugger/Programmer to PIC18F16Q20 Curiosity Nano
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CAUTION The MPLAB® PICkit™ 5 In-circuit Debugger/Programmer can deliver high voltage on the
MCLR pin. High voltage can permanently damage R209. If R209 is broken, the on-board
debugger cannot enter the programming mode of the PIC18F16Q20 and will typically fail at
reading the device ID.

CAUTION To avoid contention between the external debugger and the on-board debugger, do not
start any programming/debug operation with the on-board debugger through MPLAB® X
IDE or mass storage programming while the external tool is active.

6.6 Disconnecting the On-Board Debugger
The on-board debugger and level shifters can be disconnected from the PIC18F16Q20.

The power supply block diagram (Figure 4-5) shows all connections between the debugger and the
PIC18F16Q20. The signal names are also printed in silkscreen on the top or bottom side of the
board.

To disconnect the debugger, cut the GPIO straps shown in 4.4.1.  Cut Straps.
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Attention: Cutting the GPIO straps to the on-board debugger will disable the virtual serial
port, programming, debugging, and data streaming. Cutting the power supply strap will
disconnect the on-board power supply.

Tip: Reconnect any cut connection by using solder. Alternatively, mount a 0Ω 0402 resistor.

Tip: When the debugger is disconnected, an external debugger can be connected to
the holes. 6.5.  Connecting External Debuggers describes how to connect an external
debugger.
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Microchip Information
The Microchip Website
Microchip provides online support via our website at www.microchip.com/. This website is used to
make files and information easily available to customers. Some of the content available includes:

• Product Support – Data sheets and errata, application notes and sample programs, design
resources, user’s guides and hardware support documents, latest software releases and archived
software

• General Technical Support – Frequently Asked Questions (FAQs), technical support requests,
online discussion groups, Microchip design partner program member listing

• Business of Microchip – Product selector and ordering guides, latest Microchip press releases,
listing of seminars and events, listings of Microchip sales offices, distributors and factory
representatives

Product Change Notification Service
Microchip’s product change notification service helps keep customers current on Microchip
products. Subscribers will receive email notification whenever there are changes, updates, revisions
or errata related to a specified product family or development tool of interest.

To register, go to www.microchip.com/pcn and follow the registration instructions.

Customer Support
Users of Microchip products can receive assistance through several channels:

• Distributor or Representative
• Local Sales Office
• Embedded Solutions Engineer (ESE)
• Technical Support

Customers should contact their distributor, representative or ESE for support. Local sales offices are
also available to help customers. A listing of sales offices and locations is included in this document.

Technical support is available through the website at: www.microchip.com/support

Microchip Devices Code Protection Feature
Note the following details of the code protection feature on Microchip products:

• Microchip products meet the specifications contained in their particular Microchip Data Sheet.
• Microchip believes that its family of products is secure when used in the intended manner, within

operating specifications, and under normal conditions.
• Microchip values and aggressively protects its intellectual property rights. Attempts to breach the

code protection features of Microchip product is strictly prohibited and may violate the Digital
Millennium Copyright Act.

• Neither Microchip nor any other semiconductor manufacturer can guarantee the security of its
code. Code protection does not mean that we are guaranteeing the product is “unbreakable”.
Code protection is constantly evolving. Microchip is committed to continuously improving the
code protection features of our products.

Legal Notice
This publication and the information herein may be used only with Microchip products, including
to design, test, and integrate Microchip products with your application. Use of this information
in any other manner violates these terms. Information regarding device applications is provided
only for your convenience and may be superseded by updates. It is your responsibility to ensure

https://www.microchip.com/
https://www.microchip.com/pcn
https://www.microchip.com/support
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that your application meets with your specifications. Contact your local Microchip sales office for
additional support or, obtain additional support at www.microchip.com/en-us/support/design-help/
client-support-services.

THIS INFORMATION IS PROVIDED BY MICROCHIP "AS IS". MICROCHIP MAKES NO REPRESENTATIONS
OR WARRANTIES OF ANY KIND WHETHER EXPRESS OR IMPLIED, WRITTEN OR ORAL, STATUTORY
OR OTHERWISE, RELATED TO THE INFORMATION INCLUDING BUT NOT LIMITED TO ANY IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY, AND FITNESS FOR A PARTICULAR
PURPOSE, OR WARRANTIES RELATED TO ITS CONDITION, QUALITY, OR PERFORMANCE.

IN NO EVENT WILL MICROCHIP BE LIABLE FOR ANY INDIRECT, SPECIAL, PUNITIVE, INCIDENTAL, OR
CONSEQUENTIAL LOSS, DAMAGE, COST, OR EXPENSE OF ANY KIND WHATSOEVER RELATED TO THE
INFORMATION OR ITS USE, HOWEVER CAUSED, EVEN IF MICROCHIP HAS BEEN ADVISED OF THE
POSSIBILITY OR THE DAMAGES ARE FORESEEABLE. TO THE FULLEST EXTENT ALLOWED BY LAW,
MICROCHIP'S TOTAL LIABILITY ON ALL CLAIMS IN ANY WAY RELATED TO THE INFORMATION OR
ITS USE WILL NOT EXCEED THE AMOUNT OF FEES, IF ANY, THAT YOU HAVE PAID DIRECTLY TO
MICROCHIP FOR THE INFORMATION.

Use of Microchip devices in life support and/or safety applications is entirely at the buyer's risk,
and the buyer agrees to defend, indemnify and hold harmless Microchip from any and all damages,
claims, suits, or expenses resulting from such use. No licenses are conveyed, implicitly or otherwise,
under any Microchip intellectual property rights unless otherwise stated.

Trademarks
The Microchip name and logo, the Microchip logo, Adaptec, AVR, AVR logo, AVR Freaks, BesTime,
BitCloud, CryptoMemory, CryptoRF, dsPIC, flexPWR, HELDO, IGLOO, JukeBlox, KeeLoq, Kleer,
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QTouch, SAM-BA, SenGenuity, SpyNIC, SST, SST Logo, SuperFlash, Symmetricom, SyncServer,
Tachyon, TimeSource, tinyAVR, UNI/O, Vectron, and XMEGA are registered trademarks of Microchip
Technology Incorporated in the U.S.A. and other countries.
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TimeHub, TimePictra, TimeProvider, and ZL are registered trademarks of Microchip Technology
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Average Matching, DAM, ECAN, Espresso T1S, EtherGREEN, EyeOpen, GridTime, IdealBridge,
IGaT, In-Circuit Serial Programming, ICSP, INICnet, Intelligent Paralleling, IntelliMOS, Inter-Chip
Connectivity, JitterBlocker, Knob-on-Display, MarginLink, maxCrypto, maxView, memBrain, Mindi,
MiWi, MPASM, MPF, MPLAB Certified logo, MPLIB, MPLINK, mSiC, MultiTRAK, NetDetach, Omniscient
Code Generation, PICDEM, PICDEM.net, PICkit, PICtail, Power MOS IV, Power MOS 7, PowerSmart,
PureSilicon, QMatrix, REAL ICE, Ripple Blocker, RTAX, RTG4, SAM-ICE, Serial Quad I/O, simpleMAP,
SimpliPHY, SmartBuffer, SmartHLS, SMART-I.S., storClad, SQI, SuperSwitcher, SuperSwitcher II,
Switchtec, SynchroPHY, Total Endurance, Trusted Time, TSHARC, Turing, USBCheck, VariSense,
VectorBlox, VeriPHY, ViewSpan, WiperLock, XpressConnect, and ZENA are trademarks of Microchip
Technology Incorporated in the U.S.A. and other countries.

SQTP is a service mark of Microchip Technology Incorporated in the U.S.A.

The Adaptec logo, Frequency on Demand, Silicon Storage Technology, and Symmcom are registered
trademarks of Microchip Technology Inc. in other countries.

GestIC is a registered trademark of Microchip Technology Germany II GmbH & Co. KG, a subsidiary
of Microchip Technology Inc., in other countries.
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